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CAPITOLUL 1 
NOŢIUNI DE BAZĂ 

 

1.1. MEDIUL DE LUCRU AutoCAD2009 
După instalarea programului AutoCAD2009, pentru lansarea acestuia în execuţie, este 
necesar să se execute un dublu clic asupra pictogramei AutoCAD2009 de pe desktop-ul 
Windows.  
O altă metodă este de a folosi calea Start►Programs►Autodesk►AutoCAD 
2009►AutoCAD2009. 
Va fi afişată o fereastră ce indică numele programului şi versiunea acestuia, precum şi 
numele persoanei ce deţine licenţa. Durata de afişare a acestei ferestre este foarte redusă, 
dar utilitatea acestora pentru utilizarea sistemului este nulă.  

După încărcarea programului este afişată fereastra AutoCAD – fig. 1.1.  

Dacă se doreşte folosirea unei machete (template) se foloseşte butonul New de pe bara de 
unelte, ce are ca rezultat deschiderea ferestrei de dialog „Select template”. Din lista de 
derulantă se alege macheta dorită şi se apasă butonul Open sau se efectuează un dublu 
click pe numele machetei dorite. 

Fig. 1.1. Ecranul AutoCAD 2009. 
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Notă: 
1. Punctare/selectare – poziţionarea cursorului mouse-ului pe opţiunea dorită şi apăsarea 
scurtă a butonului din stânga al mouse-ului. 

2. Dublu clic – plasarea cursorului mouse-ului în zona dorită şi apăsarea rapidă, de două 
ori, a butonului din stânga al mouse-ului. 

3. Apăsarea butonului din dreapta al mouse-ului determină apariţia unui meniu contextual, 
plasat în poziţia în care se afla cursorul mouse-ului in momentul acţionării butonului (fig. 
1.3, 1.4). 
 

Fereastra AutoCAD_2009 
Rezultatul deschiderii programului AutoCAD 2009 este afişarea ferestrei de lucru 
(fig. 1.5). Ea conţine următoarele zone: 
- bara de titlu; 
- meniul Pull-down; 
- zona de desenare, 
- zona de comandă; 
- bara de stare; 
- meniuri mobile (floating bars). 

Fig. 1.2. Alegerea unei machete. 
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Bara de titlu 
Conţine numele programului (ex. AutoCAD 2009 – Student Version), urmat de denumirea 
fişierului şi extensia acestuia. Implicit, la deschiderea programului, este creat automat un 
fişier gol, denumit Drawing1.dwg. În cazul în care în aceeaşi sesiune de lucru se vor 
deschide mai multe fişiere goale, acestea vor fi notate DrawingX.dwg, unde X = 1, 2 ... n. 

Bara Standard 
Conţine butoane pentru cele mai utilizate comenzi din meniul File (New, Open, Save, 
Print, Undo, Redo). 

Bara de tip „ribbon” 
Conţine reprezentările grafice ale diferitelor opţiuni/comenzi din meniurile derulante. Dacă 
unul din simbolurile grafice va conţine în partea dreată şi o săgeată orientată în jos, la 
efectuarea unui clic pe acea săgeată de va deschide o listă de opţiuni ale comenzii 
respective. 

Meniul Pull-down 
Poziţionat în colţul din stânga sus al ecranului AutoCAD (sub forma unui simbolului literei 
„A”, oferă utilizatorului acces şa majoritatea funcţiilor şi comenzilor AutoCAD (fig. 1.7). 
Opţiunile/comenzile din aceste meniuri sunt disponibile prin selectare. Dacă opţiunea 
conţine subopţiuni (în partea dreaptă a denumirii opţiunii se află simbolul ►), accesul la 
acestea se face prin efectuarea unui clic pe numele opţiunii. În cazul în care o 
opţiune/comandă este urmată de 3 puncte (…), la selectarea acesteia are loc deschiderea 
unei ferestre de dialog. De exemplu, selectarea comenzii File-New…(CTRL+N) are ca 
rezultat deschiderea ferestrei „Select template” – prezentată în fig. 1.2. Închiderea meniului 
fără accesarea unei comenzi/opţiuni se face prin apăsarea tastei Esc. 

Fig. 1.5. Fereastra AutoCAD 2009. 
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Zona de comandă 
Este plasată la partea inferioară a ferestrei şi cuprinde:  
- o fereastră de comandă ce conţine ultimele două rânduri afişate de sistem. Aceste rânduri 
pot fi comenzi date de utilizator sau mesaje returnate de sistem la efectuarea unei comenzi. 

Fig. 1.7. Opţiuni/comenzi ale meniurilor derulante. 

Fig. 1.6. Lista opţiunilor unei comenzi. 
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Numărul de rânduri pe care se efectuează afişarea poate fi definti de utilizator (va fi tratat 
ulterior). Comenzile date de utilizator sau mesajele sistemului pot fi vizualizate oricând 
prin acţionarea butoanelor de defilare, plasate în partea dreaptă a ferestrei de comandă şi 
marcate cu sageţi sus/jos (sensul săgeţii indică sesnul de deplasare în fereastra de 
comandă). 

- o linie de comandă de afişează prompt-ul Command:. Afişarea prompt-ului indică 
utilizatorului că sistemul aşteaptă o comandă. Indiferent daca o comandă este selectată 
dintr-un meniu sau de pe un buton, în linia de comandă va fi afişată denumirea comenzii şi 
eventualele opţiuni. Dacă denumirea unei comenzi este scrisă în linia de comandă, este 
necesară apăsarea tastei <Enter> pentru lansarea în execuţie a acesteia. În majoritatea 
cazurilor, pe ultima linie din zona de comandă vor fi returnate mesajele sistem. 
Coordonatele poziţiei curente 
Acestea afişează poziţia în plan sau spaţiu a cursorului mouse-ului. Poziţia cursorului este  
dată de axele de coordonate (x, y, z); axele x şi y fiind în planul monitorului – în sensul 
indicat de simbolul sistemului de coordonate, iar axa z fiind perpendiculară pe monitor, 
orientată de la monitor spre utilizator.  

Butoanele indicatoare 
Au rolul de a indica utilizatorului care opţiuni sunt active sau nu. Pentru activarea sau 
dezactivarea unei opţiuni se poate efectua un clic pe butonul corespunzător.  

De exemplu, efectuarea unui clic pe butonul „Grid display” are ca efect afişarea unei reţele 
de puncte pe ecran. Efectuarea unui al doilea clic pe acelaşi buton duce la dezactivarea 
comenzii şi ascunderea reţelei de puncte.   
 

1.2. SISTEMUL DE COORDONATE UNIVERSAL ŞI UTILIZATOR 
Un sistem CAD are ca funcţii crearea, memorarea şi manipularea informaţiilor geometrice. 
Îndeplinirea acestor funcţii este posibilă doar dacă informaţiile sunt convertite în date 
numerice. Această conversie este realizată prin utilizarea coordonatelor carteziene  
Coordonatele carteziene  - reprezintă coordonatele care sunt raportate – sub forma 
distanţelor – la un sistem de referinţă format dintr-un număr de drepte concurente egal cu 
numărul dimensiunilor spaţiului de lucru. Sistemul AutoCAD utilizează un spaţiu de lucru 
tridimensional în care cele trei drepte – denumite axe – sunt perpendiculare două câte două 
– coordonate carteziene rectangulare. În acest sistem de coordonate, axele se intersectează 
într-un punct, care poartă denumirea de origine şi este în mod curent notat cu O. Prin 
poziţia relativă faţă de origine şi atribuirea unui sens de parcurgere fiecărei axe se obţine o 
codificare univocă a oricărui punct al planului. În mod implicit în AutoCAD, axele 
sistemului de coordonate plan au sensul de la stânga la dreapta pentru axa Ox şi de jos în 
sus pentru axa Oy. În acest sistem, un punct are coordonate pozitive dacă, faţă de origine, 
se găseşte în sensul parcurgerii celor două axe, altfel coordonatele fiind negative. În 
fig. 1.8 este înfăţişată definirea unor puncte într-un sistem de coordonate plan. Sistemul 
spaţial de coordonate carteziene are cea de a treia axă – cota – perpendiculară pe planul 
format de abscisă şi ordonată şi notată în mod curent cu litera z. Cota intersectează planul 
xOy în originea O şi are sensul identic cu sensul de înaintare a unui burghiu care se roteşte 
în sens trigonometric – invers acelor ceasornicului. Concluzia este că, în spaţiul de lucru 
AutoCAD, oricare punct este definit printr-un triplet de numere care reprezintă 
coordonatele carteziene ortogonale ale punctului (abscisa – x, ordonata – y, cota – z). În 
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fig. 1.9 este înfăţişată definirea unor puncte într-un sistem spaţial de coordonate carteziene 
ortogonale. 
Coordonate polare  - în plan sunt formate din distanţa r – raza vectoare – de la un punct 
fix O (originea sistemului) până la punctul considerat şi unghiul θ (unghi polar) pe care îl 
face raza vectoare cu o dreaptă fixă Ox, aleasă convenţional şi care trece prin origine, 
măsurat în sens trigonometric de la Ox la raza vectoare – fig. 1.10. În spaţiu, coordonatele 
sunt: raza vectoare r; unghiul polar θ (longitudine) dintre raza vectoare şi dreapta Oz, 
măsurat în sens trigonometric de la Oz la raza vectoare; unghiul φ (latitudine) în planul 
xOy, masurat între proiecţia razei vectoare pe acest plan şi dreapta Ox, în sens 
trigonometric de la Ox la proiecţie. Acest sistem de definire poartă denumirea de sistem de 
coordonate sferice – fig. 1.11. 
Coordonate cilindrice – reprezintă un sistem de coordonate format din coordonatele 

Fig. 1.8. Coordonate carteziene în plan. 

Fig. 1.9. Coordonate carteziene în spaţiul 3D.
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Fig. 1.11. Coordonate sferice.

Fig. 1.12. Coordonate cilindrice. 

Fig. 1.10. Coordonate polare în plan.
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polare ale proiecţiei ortogonale a unui punct din spaţiu pe un plan fix xOy şi cota punctului 
măsurată pe axa Oz – fig. 1.14. 

Sistemul de coordonate universal şi utilizator 
Sistemul de coordonate universal întâlnit în aplicaţiile grafice CAD (deci şi AutoCAD 
2009) sub prescurtarea WCS – World Coordinates System – reprezintă un sistem spaţial de 
coordonate carteziene ortogonale, având axele infinite şi cu următoarea amplasare: planul 
xOy este planul ecranului cu originea O în colţul din stânga jos a acestuia, axa Ox are 
sensul de la stânga la dreapta, iar Oy de jos în sus; axa Oz este perpendiculară pe ecran în 
originea O şi sensul de la ecran la utilizator. Acest sistem este permanent fix în raport cu 
modelul reprezentat, constituind singurul sistem de referinţă imuabil printre celelalte 
sisteme utilizate în cadrul aplicaţiilor grafice CAD. Din acest motiv, indiferent de sistemul 
de coordonate utilizat în modul curent de lucru, aplicaţiile grafice CAD memorează 
permanent coordonatele punctelor elementelor grafice în sistemul de coordonate universal. 

Sistemul de coordonate utilizator întâlnit în aplicaţiile grafice CAD sub prescurtarea UCS 
– User Coordinates System – reprezintă un sistem spaţial de coordonate carteziene creat şi 
amplasat convenabil de utilizator, în vederea facilitării construcţiei entităţilor grafice ale 
modelului. Acest sistem este temporar, având cel mult durata sesiunii de lucru în care a 
fost creat. Utilitatea UCS-urilor iese în evidenţă în cazul construirii entităţilor coplanare ale 
unui model spaţial; în acest caz, se creează un UCS având axele Oxu şi Oyu definite în 
planul entităţilor, ceea ce permite ca, prin omiterea coordonatelor zu în timpul construcţiei, 
volumul şi complexitatea calculelor să se reducă considerabil. 

Trecerea coordonatelor punctelor unei entităţi geometrice definite în UCS în WCS este 
realizată de sistem automat prin aplicarea unei matrici de rotaţie şi/sau vector de translaţie. 

Coordonate absolute - sunt utilizate pentru definirea poziţiei unui punct (în WCS sau 
UCS) prin intermediul coordonatelor sale carteziene. Fie punctul P de coordonate 
x1, y1, z1 atunci poziţia sa în sistemul de coordonate curent este dată de tripletul 
coordonatelor despărţite prin virgulă x1,y1,z1 (nu este permisă includerea de spaţii libere 
în şirul de coordonate). 
În cazul în care punctul se găseşte în planul xOy al sistemului de coordonate curent (deci 
cota este 0) el poate fi definit doar prin coordonatele x şi y (cota poate fi ignorată). 
În concluzie prin coordonatele absolute un punct este direct poziţionat faţă de originea 
sistemului de coordonate implicit. 
Coordonate relative - sunt utilizate pentru definirea poziţiei unui punct în raport cu 
ultimul punct memorat de sistem. Definirea se poate realiza sub trei forme: în coordonate 
carteziene, coordonate cilindrice sau coordonate sferice. 

Luând ca exemplu figurile 1.10, 1.11 şi 1.12 în AutoCAD2009, forma de definire este 
următoarea: 

@r<ϕ – coordonate relative polare plane; 
@r<ϕ<θ – coordonate relative sferice; 
@r<ϕ,zp – coordonate relative cilindrice; 
@x,y,z – coordonate carteziene relative. 

Caracterul “@” comunică sistemului că setul de coordonate care urmează trebuie 
interpretate ca şi coordonate relative, respectiv au ca punct de plecare ultimul punct 
memorat (în cazul de faţă originea sistemului). 
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Notă: În mod implicit în AutoCAD unghiurile pozitive se măsoară plecând de la 
orizontală în sens antiorar. În cazul în care unghiul este negativ el va fi măsurat în sens orar 
– fig. 1.13. 

Specificarea directă a distanţei 
Un nou punct în AutoCAD poate fi specificat şi prin introducerea directă a distanţei faţă de 
punctul anterior memorat. Distanţa este automat măsurată pe direcţia liniei elastice care 
leagă punctul anterior memorat de cursorul mouse-lui.  

Metoda este deosebit de productivă în cazul desenării unei înlănţuiri de linii ortogonale 
două câte două. În această situaţie se activează modul ORTHO (se selectează al treilea 
buton din bara de stare), se dă comanda line, se indică punctul de start, după care, la fiecare 
nou prompt se introduc numai lungimile segmentelor dorite. La fiecare nouă introducere 
orientarea liniei elastice trebuie să fie apropiată de orizontală sau verticală în funcţie de 
orientarea segmentului respectiv. 

Notă: Modul ORTHO dacă este activat determină AutoCAD-ul să traseze doar linii 
paralele cu axele Ox şi Oy indiferent de poziţia cursorului. Linia va avea direcţia celei mai 
mari proiecţii a liniei elastice pe cele două axe (dacă proiecţia pe Oy este mai mare decât 
proiecţia pe Ox atunci linia este verticală, altfel orizontală). 

Linia elastică reprezintă o linie dusă automat de sistem, care uneşte punctul anterior 
memorat cu cursorul mouse-lui.  

Pentru mai buna înţelegere mediului de lucru şi a modului de utilizare a coordonatelor 
relative ca primă aplicaţie vom desena formatul STAS A5 – fig. 1.14 (aplicaţia 1.1). 

Pentru început înainte de a lansa în lucru AUTOCAD 2009 va fi creat subdirectorul 
Formate în cadrul subdirectorului AUTOCAD 2009. În cazul în care nu ştiţi cum, urmăriţi 
secvenţă următoare.  
►Start (din fereastra Widows) ►Programs►Accessories►Windows Explorer  

Apare o casetă de explorare care cuprinde două ferestre. Cea din stânga conţine lista 
unităţilor logice din sistem şi implicit structura arborescentă a primei partiţii a hard-

Fig. 1.13. Definirea unghiurilor în AutoCAD.
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discului master – unitatea logică C:. Cea din dreapta conţine lista conţinutului directorului 
(subdirectorului selectat în fereastra din stânga). 
►butonul + din dreptul subdirectorului Program Files (fereastra  din stânga) ► 
AUTOCAD 2009 ► File (din meniul casetei) ►New►Folder  

În fereastra din dreapta este automat creat un nou subdirector cu eticheta New Folder 
selectată. Tastaţi Formate şi daţi Enter. Se închide caseta de explorare din butonul cu 
simbolul “X” din colţul din dreapta sus al casetei. 

1.3. ÎN CAZUL ÎN CARE GREŞIŢI 
În timpul unei sesiuni de lucru greşelile sunt inevitabile chiar şi pentru profesionişti. În 
continuare sunt prezentate câteva modalităţi de remediere a greşelilor: 

Greşeala Remediere 
Lansarea în execuţie a unei 
comenzi nedorite sau alegerea 
unei opţiuni greşite – se 
doreşte ieşirea forţată din 
comanda curentă. 

Se apasă tasta Esc şi se revine la prompt-ul Command; în 
unele cazuri, pentru anularea comenzii curente este 
necesară apăsarea de mai multe ori a tastei Esc. 

Selectarea greşită a unei 
opiuni dintr-un meniu 
oarecare 

Prin selectarea opţiunii corecte este anulată selecţia 
anterioară. 

Execuţia unei comenzi a cărui 
efect se doreşte anulat 

Se tastează “U” în linia de comandă, se foloseşte 
combinaţia de taste CTRL+Z sau de apasă butonul  

Anularea din greşeală a unei 
comenzi bune 

Imediat după anulare se tastează Redo în linia de comandă, 
se foloseşte combinaţia de taste CTRL+Y sau se foloseşte 
butonul  

Iniţierea unei selecţii înaintea 
lansării în execuţie a unei 
comenzi 

În cazul selectării entităţilor, acestea vor fi marcate cu mici 
pătrate colorate denumite “grips”. Pentru anularea acestei 
selecţii se apasă taste Esc de două ori.  

 

Fig. 1.14. Formatul STAS A5. 
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Punctarea din greşeală în zona 
grafică 

Are loc iniţierea operaţiei de selectare (în linia de comandă 
apare mesajul “Other corner” (“Celălalt colţ”) simultan cu 
afişarea unui dreptunghi colorat ce delimitează o zonă de 
selecţie. Anularea selecţiei se realizează prin apăsarea 
tastei Esc. 

Notaţii folosite 
MD – meniu derulant 
LC – linie de comandă 

TB – bară de unelte. 

1.4. APLICAŢIA 1 
Se deschide sesiunea AutoCAD şi din caseta Startup se selectează opţiunea Start from 
Scratch. 
►Start►Programs►Autodesk►AutoCAD Architecture 2009►New►Select Template 
acad.dwt►OK 
În această fază sistemul de lucru este implicit configurat cu următoarele caracteristici: 
unitatea de desenare = milimetrul; dimensiunile suprafeţei de modelare (în planul 
ecranului, deci cu cota 0) = 420x297 mm. 
Modificăm limitele suprafeţei de modelare la dimensiunile formatului STAS A5. 

MD Format ►Drawing Limits 

LC  '_limits 
 Reset Model space limits: 

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 
Specify upper right corner <420.0000,297.0000>: 210,148 

Dacă doriţi şă vizualizaţi mai bine suprafaţă de modelare activaţi opţiunea GRID (butonul 
se află în bara de stare). Dacă modul GRID este activ pe suprafaţa de modelare este afişată 
o reţea de puncte. Aceste puncte au rol pur informativ (dau o idee utilizatorului despre 
amplasarea entităţilor modelate) şi nu fac parte din modelul reprezentat (imaginea obţinută 
nu cuprinde grid-urile dacă modelul este tipărit). În mod implicit grid-urile sunt 
echidistanţate din 10 în 10 mm. 
Pentru a vizualiza/ascunde coordonatele punctului de amplasare a cursorului daţi clic pe 
zona din bara de stare în care sunt afişate coordonatele punctului curent. 
Activarea/acunderea afişării coordonatelor va fi semnalată prin mesajul <Coords 
on>/<Coords off> în zona de comandă. 
Deoarece tot formatul A5 este constituit doar din linii ortogonale două câte două activăm 
modul ORTHO selectând butonul corespunzător din bara de stare. Activarea modului este 
semnalată prin afişarea mesajului <Ortho on> în zona de comandă. 

NOTĂ: Când comenzile date sistemului în zona de comandă sunt precedate de 
caracterul “–“ atunci eventuala casetă de dialog care în mod implicit ar fi afişată, este 
ignorată. Sistemul afişează obişnuita linie de opţiuni din variantele DOS ale AutoCAD-
ului.  

Dacă o comandă este precedată de caracterul ‘ ea poate fi lansată în execuţie în mod 
transparent (adică poate fi lansată în execuţie din interiorul altei comenzi). 
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Se desenează chenarul exterior al formatului începând cu punctul de coordonate 
absolute 0,0.  
LC Line sau L 
TB 

 
 Specify first point: 0,0 Specify next point or [Undo]: 210  Înainte de a tasta 

210 se amplasează cursorul în punctul 1 –  fig.1.15 
Specify next point or [Undo]: 148  Înainte de a tasta 148 se amplasează 
cursorul în punctul 2 –  fig.1.15 
Specify next point or [Close/Undo]: 210 Înainte de a tasta 210 se 
amplasează cursorul în punctul 3 –  fig.1.15 
Specify next point or [Close/Undo]: c 

Primul colţ al chenarului (de coordonate 0,0) a fost definit în coordonate absolute, iar 
celelalte 3 prin specificarea directă a distanţei. Astfel: 

Al doilea colţ este definit faţă de primul ca aflându-se la distanţa de 210 mm pe direcţia Ox 
(direcţia proiecţiei liniei elastice dusă automat de sistem până în punctul în care este 
poziţionat cursorul – adică punctul 1). Reamintim că direcţia este cea a proiecţiei şi nu a 
liniei elastice deoarece modul ORTHO este activ.  
Al treilea colţ este definit faţă de al doilea ca fiind la o distanţă de 148 mm pe direcţia 
proiecţiei liniei elastice dusă de sistem până în punctul 2 unde este poziţionat cursorul.  
Al patrulea colţ este definit faţă de al treilea ca fiind la o distanţă de 210 mm pe direcţia 

Fig. 1.15. Indicarea colţurilor 2, 3, 4 ale chenarului. 



 

23 
 

 

proiecţiei liniei elastice dusă de sistem până în punctul 3 unde este poziţionat cursorul.  

NOTĂ: În continuare textul “Înainte de a tasta xxx amplasează cursorul în punctul 
y” va fi înlocuit de simbolul >y. 
Se desenează chenarul exterior al formatului începând cu punctul de coordonate absolute 
20,5 şi linia orizontală interioară din punctul 20,17 (linia superioară a indicatorului). 
Se desenează chenarul exterior al formatului începând cu punctul de coordonate absolute 
20,5 şi linia orizontală interioară din punctul 20,17 (linia superioară a indicatorului). 
LC Line sau L 
TB 

 
 _line Specify first point: 20,5 

Specify next point or [Undo]: 185   > 1 –  fig.1.15 
Specify next point or [Undo]: 138   > 2 –  fig.1.15 
Specify next point or [Close/Undo]: 185 > 3 –  fig.1.15 
Specify next point or [Close/Undo]: c 
Command: 
LINE Specify first point: 20,17 
Specify next point or [Undo]: 185   > 1 –  fig.1.15 
Specify next point or [Undo]: 

 
NOTĂ: Pentru desenarea liniei superioare a indicatorului nu a mai fost necesară tastarea 
comenzi LINE sau selectarea simbolului corespunzător din (TB), fiind suficient darea unui 
Enter la apariţia prompt-ului Command:. Aceasta deoarece AutoCAD-ul are inclusă 
facilitatea de a repeta ultima comandă executată în cazul în care la apariţia prompt-ului 
Command: se răspunde cu Enter sau tasta Spaţiu. 
Această facilitate poate fi periculoasă în cazul în care ultima comandă a fost U (reamintim 
că anulează ultima comandă efectuată), deoarece în această situaţie fiecare Enter dat 
anulează câte o comandă executată. În cazul în care din greşeală au fost anulate mai multe 
comenzi doar ultima poate fi recuperată (comanda REDO) restul fiind definitiv pierdute. 
Se desenează liniile verticale ale indicatorului – fig 1.16. 

LC Line sau L 
TB 

 
 Command: 

LINE Specify first point: 30,5  Rezultă punctul 1 – fig. 1.16 
Specify next point or [Undo]: @0,12  Rezultă punctul 2 – fig. 1.16 
Specify next point or [Undo]: 
Command: 
LINE Specify first point: @42,0  Rezultă punctul 3 – fig. 1.16 
Specify next point or [Undo]: @0,-12  Rezultă punctul 4 – fig. 1.16 
Specify next point or [Undo]: 
Command: 
LINE Specify first point: @8,0  Rezultă punctul 5 – fig. 1.16 
Specify next point or [Undo]: @0,12  Rezultă punctul 6 – fig. 1.16 
Specify next point or [Undo]: 
Command: 
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LINE Specify first point: @40,0  Rezultă punctul 7 – fig. 1.16 
Specify next point or [Undo]: @0,-12  Rezultă punctul 8 – fig. 1.16 
Specify next point or [Undo]: 

 Command: 
LINE Specify first point: @15,0  Rezultă punctul 9 – fig. 1.16 
Specify next point or [Undo]: @0,12  Rezultă punctul 10 – fig. 1.16 
Specify next point or [Undo]: 

De data aceasta fiecare punct (în afară de primul) a fost introdus prin coordonate carteziene 
relative la punctul anterior definit. 

NOTĂ: În aplicaţiile următoare textul “Rezultă punctul x” va fi înlocuit cu simbolul ⇒ x 
Se salvează desenul în subdirectorul formate. 
► File ► Save as ► Formate (dacă subdirectorul nu apare în listă selectaţi triunghiul 
casetei de editare Save in şi selectaţi subdirectorul AutoCAD2009) ► File name (în caseta 
de editare se tastează A5.dwt) ► Save 

Se iese din mediul AUTOCAD 2009 
► File ► Exit 

În acest moment în subdirectorul Formate din subdirectorul AutoCAD2009 aveţi un fişier 
cu denumirea A5.dwg care conţine desenul formatului STAS A5. 

 

 

Fig. 1.16. Desenarea elementelor indicatorului A5. 


